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Customer Support & Legal

For technical support, send an email to rpc@arri.com, or contact one of the following ARRI affiliates:

Germany Arnold & Richter Cine Technik
Türkenstraße 89, D-80799 Munich, Germany
Voice phone: +49 (0)89 3809-0, FAX: +49 (0)89 3809-1244
Email: webmaster@arri.de

Canada ARRI Canada Limited
415 Horner Avenue, Unit 11, Toronto, Ontario, M8W 4W4 Canada
Voice phone: +416 255 3335, FAX: +416 255 3399
Email: email@arrican.com

England ARRI GB Ltd.
1-3 Airlinks, Spitfire Way, Heston, Middlesex, TW5 9NR, England
Voice phone:+44 (0)181 848 8881, FAX: +44 (0)181 561 1312
Email: Info@arri-gb.com

Italy ARRI Italia S.r.l., Head Office
Edison 318, 20099 Sesto San Giovanni (Milan), Italy
Voice Phone: +39 (02) 262 271 75, FAX: +39 (02) 242 1692
Email: info@arri.it

ARRI Italia S.r.l.
Via Placonia 97, 00040 Morena (Rome), Italy
Voice Phone: +39 (06) 79 89 021, FAX: +39 (06) 79 89 02 206
Email: info@arri.it

USA ARRI USA Inc., East Coast
617 Route 303, Blauvelt, NY 10913-1109, USA
Voice phone: 845-353-1400, FAX: 845-425-1250
Email: arriflex@arri.com

ARRI USA Inc., West Coast
600 North Victory Blvd., Burbank, CA 91502-1639, USA
Voice phone: 818-841-7070, FAX: 818-848-4028
Email: brussell@arri.com

Information about the RPC and more can be found on the ARRI website at:

http://www.arri.com

Neither Arnold & Richter Cine-Technik nor its affiliates are to be held liable in any form for any information given in this
document.

Arnold & Richter Cine-Technik and its affiliates do not assume any responsibility with regard to the performance or use of
the Ramp Preview Controller software and all included files and documentation. Arnold & Richter Cine-Technik and its
affiliates offer no warranties, express or implied, regarding the accuracy, sufficiency, suitability, merchantability or fitness for
a particular purpose of the software or other materials delivered herewith. Customers have the responsibility for inspecting
and testing all functions to their satisfaction before using them with important data. Even though every effort has been made
to ensure that the information in this guide is accurate, the users are encouraged to verify the data presented here for
themselves. Subject to change without notice.

Mention of third party products is for informational purposes only and constitutes neither an endorsement nor a
recommendation. Apple, Finder, ImageWriter, LaserWriter, Mac, Macintosh, Hypercard and PowerBook are registered
trademarks of Apple Computer, Inc. QuickTime™ and the QuickTime logo are trademarks used under license.

© 2000 Arnold & Richter-Cine Technik. All Rights Reserved.
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About The RPC Documentation

Documentation Overview

The documentation for the Ramp Preview Controller consists of the following files which are all in
Adobe Acrobat PDF format and can be found on the Ramp Preview Controller CD-ROM.

Since the Windows and Macintosh versions of the RPC have virtually the same features and
interfaces, the RPC documentation covers both versions.

• RPC Overview.pdf
A 4 page document giving a short overview of the Ramp Preview Controller. Give this to your boss
if asked what the RPC does.

• RPC Installation Guide.pdf
Everything you need to know to install and authorize the Ramp Preview Controller.

• RPC Operations Guide.pdf
The operations guide consists of two parts:
1. How to… : This part describes how to accomplish the most common tasks.
2. Reference: This part describes every window, button and menu item in detail.

• Ramp Tutorial.pdf
This short tutorial is required reading for anyone who works with ramps! You can either read the
PDF version on the CD-ROM, or choose “Ramp Tutorial” from the Help menu when the Ramp
Preview Controller is running.

• P-1026 RPC Video Capture.pdf
Tips and hints on digitizing video for use with the RPC.

• P-1027 USB.pdf
A short description on how to connect a camera to computers with a USB port.

Definitions

Mentioning the 16SR 3 implies the 16SR 3HS, unless specifically noted otherwise.

The term "435" will stand for the 435 (Standard) and for the 435ES (Electronic Shutter). If we want to
make a distinction, we will specifically note "435 (Standard)" and "435ES".

Normal Speed  is the speed at which an action has the same shoot time and screentime.

Offspeed  is any camera speed that is not the same as the playback speed.

A Combo Box  is a fast way to choose a number on the computer. It consists of a text entry field and
an associated menu. Numbers can be typed directly into the text entry field, or chosen from the
menu.

The Speed Combo Box

Text Entry Field

Click here to open Menu

Once the combo box has been clicked on, you can quickly step through the numbers in the menu with
the arrow up or down keys on the keyboard.



RPC Operations Guide, Page 8

The combo boxes used in the RPC has another time saving feature. If the number in the text entry
field is not in the menu, the first item in the menu can add that number to the menu. Conversely, if the
number in the text entry field is already present in the menu, the first item in the menu will offer to
remove the number from the menu (see picture). That way the menu can be quickly customized.
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Introduction To The RPC

A unique feature of the current generation of Arriflex film cameras is their ability to change camera
speed while the camera is running. Such a speed change is called a “ramp”. Even though ramps are
used extensively by some technology savvy DPs, others shy away because of the costly trials and
errors involved in learning their proper use. Until now, previous experience has been the only way to
judge the ramp settings to use on the set, since no method for accurate pre-visualization existed.

All that has changed with the introduction of the ARRI Ramp Preview Controller software (RPC). Now
the result of a ramp can be instantly previewed during pre-production or on the set, avoiding costly
mistakes and re-shoots.

Using the RPC is simple. During a rehearsal the video assist is digitized into a Desktop or Laptop
computer. Ramp settings are entered into the RPC and a preview of the effect is played back. Ramp
settings can then be adjusted and the result can be viewed immediately to find the best settings for
the desired effect. Because this can be done during blocking or pre-lighting, the RPC will integrate
smoothly into the workflow on the set. Once a ramp is decided upon, the RPC can be connected to
the film camera to shoot the ramp on film.

What the RPC Cannot Do

To use the RPC in a useful manner, it is important to understand what it can and cannot do.

The RPC can show how the speed of an action will change when a ramp is used to film the action.

It cannot show any shutter related effects like motion blur or strobing, and it does not concern itself
with the image quality, i.e. no steps have been taken to attempt to emulate the “film look” or change
the image in any other way. It will not show any changes in exposure when the shutter angle is set
incorrectly.

The RPC currently has no video capture features. This will have to be done with third party software.
The ARRI Technical Note “P-1026 RPC Video Capture” discusses this subject in detail.
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Part 1: How To…
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How To Get Help

• Read the Documentation provided on the CD-ROM.
• Rest the cursor over any item on the screen, and a small explanation will pop up. We call this

"Quick Help". Once you are familiar with the RPC and Quick Help starts to annoy you, disable it by
choosing Quick Help from the View menu. The Quick Help item in the View menu has a checkmark
when it is enabled, no checkmark when it is disabled.

• The Camera and Compensation menus contain help information.
• The Preferences and Connect to Camera windows have their own Help buttons that provide useful

tips and hints.
• The Help menu contains a Ramp Tutorial and a Reverse Ramp Tutorial.
• Send an email to rpc@arri.com, or contact your local ARRI representative.

How to Create a New Ramp

• Start the Ramp Preview Controller (RPC).
• The RPC stores a number of ramps in a file called a “Ramp Archive”. Only one Ramp Archive can

be open at a time. The open Ramp Archive will be displayed in the Ramp Editor window, and its
name will be displayed in the Ramp Editor’s title bar (see picture below).

• If you do not see the Ramp Editor window, choose “Ramp Editor” from the “View” menu.
• To create a new ramp to be added to this ramp archive, click the “New” button.
• Enter a name for the ramp in the Ramp menu.

Ramp Menu New ButtonRamp Archive Name
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How to Edit a Ramp

• Using the “Mode” and “Type” radio buttons in the Ramp Editor, choose a ramp mode and ramp
type. If you do not know what those are, choose “Ramp Tutorial” from the “Help” menu. Please note
that Internal Ramps are limited to a 100 second shoot time duration.

• Using the “Camera” and “Compensation” menus in the Ramp Editor, choose a camera and
compensation method you will be using. This will impose the exact same limits on this ramp as the
chosen camera and compensation method have. If you are unfamiliar with those limits, choose the
Help item from the Camera or Compensation menus.

• Now grab a ramp point and drag it somewhere else on the ramp graph. A ramp point is a point
representing a camera speed and shutter angle. You will see the screentime (red numbers) and
shoot time (gray numbers) change as you drag the ramp point. A ramp segment consists of a ramp
point and all speed, shutter and duration values from the previous ramp point to this ramp point.
When a ramp point is clicked, the whole ramp segment is selected and turns orange (see picture).

• You will also see the Ramp Segment Properties (fps, shutter angle, screentime, shoot time)
change. If you want to, you can select a ramp segment by clicking its associated ramp point, and
then type a new value into one of the Ramp Segment Properties fields, or chose a predefined value
from the Ramp Segment Properties menus.

a

Ramp Point

Ramp GraphRamp Segment Properties

Screentime

Shoot time

• When editing an external ramp, new ramp points can be created with the Add button. It will be
inserted after a selected ramp point or at the end of the whole ramp.

• Selected ramp points can be deleted with the Delete button.
• Selecting a ramp point and clicking the “FAP” button makes that ramp segment as Fast As

Possible, given the limitations imposed by the chosen camera and compensation method.
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How to Capture Video

In order to preview a ramp, some video must have been captured into the computer. The RPC
currently does not have any features that allow video capture, so you must use third party software.
The ARRI Technical Note “P-1026 RPC Video Capture” discusses this subject in more detail.

The RPC can open a variety of video file formats, including: QuickTime Movies (.mov), AVI files (.avi),
DV files (.dv), MPEG-1 files (Mac OS) and Open DML files.

When using a SONY VAIO Laptop, please be aware that you should not run the “DV Gate Motion”
software at the same time you are running the Ramp Preview Controller.

How to Preview a Ramp

• Make sure the Ramp Editor is open before you preview a ramp.
• Click on the Preview button in the Ramp Editor, and choose a movie to preview.
• Make sure the Ramp tab in the Preview window is in the front.

Ramp Tab

• Now you must set at least one Preview Trigger, so the RPC knows where in the movie you want the
ramp to start. There are two methods for setting Preview Triggers:

1. The Quick Method
• Move the cursor over the Preview Timeline.

Preview Timeline

• Now push the mouse button down and keep it held down. A Preview Trigger will appear on the
Timeline. Don’t let go of the mouse button yet; instead move the cursor to the left or right to scrub
through the movie. Once you get to the place in the movie where you want the Preview Trigger to
occur, let go of the mouse button.

Preview Trigger

• When at least one Preview Trigger is set, click the Play Preview button to see the preview.
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2. The Rehearsal Method
• Click the Record Triggers button to erase all existing Preview Triggers and play the movie at

normal speed.
• Once the movie reaches the point where you want the Preview Trigger to occur, click the Set

Trigger button.
• When at least one Preview Trigger is set, click the Play Preview button to see the preview.

1. Click Record Triggers to erase all existing Preview
   Triggers and to play movie at normal speed.

2. Once you the movie reaches the point where you want
   the ramp to start, click Set Trigger.

3. Click Play Preview to view the ramp preview.

Offspeed Tab
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How to Erase Preview Triggers

Preview Triggers can be erased by dragging them down, out of the Preview Timeline.

Drag Preview Trigger out of
timeline to erase

How to Limit the Preview

To start the preview later and/or end it earlier, move the Preview In and Preview Out flags.

Preview In Flag Preview Out Flag
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Notes on Preview Triggers

• Preview Triggers can be dragged to a different position at any time.
• For Internal Ramps, each new Preview Trigger will affect a reversal in the ramp direction, that is the

ramp will bounce back and forth between the two set ramp speeds.

Creating multiple triggers for an
Internal Ramp will make the ramp
toggle between the first and the
second ramp speed.

• For External Ramps, each new Preview Trigger will be associated with a ramp point from the Ramp
Editor until no more ramp points are left. Any new Preview Triggers will be empty (marked with a “-“)
and will have no effect. Please note that the last ramp point in an external ramp has no
corresponding preview trigger, as it ends the ramp.

Creating multiple triggers for an
External Ramp will create empty
triggers if no ramp points are
defined in the Ramp Editor.
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How To Preview a Post-Production Ramp

Sometimes it is preferable to shoot a take at the highest speed available, and to create the ramping
effect in post production. This can also be previewed on the RPC:

• In the Ramp Editor, set the Camera and Compensation menus to “None”. This will remove all
limitations from this ramp. When the Camera menu is set to None, only external ramps are possible.

• In the Preferences, go to the Ramps section and set the Maximum Speed and Film Format for the
None camera.

• Now you can edit the ramp in the Ramp Editor, and preview in the Preview window. Please note
that you can now preview ramps that no real camera can accomplish.

How to Preview an Offspeed

• To open the Preview window, either click on the Preview button in the Ramp Editor, or choose the
Preview command from the View menu. Choose a movie to preview.

• Click on the Offspeed tab in the Preview window.
• Choose a Film Format and camera speed (Shoot fps).
• Click the Play Preview button.
• Once the Offspeed preview is playing, you can change the Shoot fps either by choosing a different

speed from the Shoot fps combo box.
Once the combo box has been clicked on, you can quickly step through the numbers in the menu
with the arrow up or down keys on the keyboard. To use the arrow up/down keys to change the
QuickTime audio volume, either click in the movie window or hit the tab key once.

3. Click Play Preview.

2. Set the camera speed you want to preview.

1. Set the Film Format.
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How To Connect to a Real Camera

The RPC cable that connects the computer to the camera is identical to the cable used for the Laptop
Camera Controller (LCC). They can be used interchangeably.

DO NOT use any cables that are not clearly marked "RPC", "LCC" or "WLCC". The Arriflex CCU
cable (KC-24 or KC-30) has the same connectors as the Windows RPC and Windows LCC cables,
but should NOT be used to connect a computer to a camera. The CCU cable is wired differently and
carries 24 Volts power, which could damage your computer!

• Insert the Fischer connector of a RPC or LCC Cable into the CCU receptacle on the camera. Insert
the other end of the cable (D-9 pin for PCs, Mini DIN 8 for Macs) into the computer’s serial port.
If your computer does not have a serial port, but instead has a USB port, you can use a USB to
serial adapter. See the ARRI Technical Note P-1027 (included on the RPC CD-ROM) for details.

• Choose Connect to Camera from the View menu, or click the Camera button in the Ramp Editor.
• Set the Connect To menu to Real Camera.
• Set the Connect Through menu to the communications port your cable is plugged into.
• Click the Connect button.
• Once the RPC connects to a real camera, it will automatically bring the Camera Controller window

to the foreground.
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How To Connect to a Virtual Camera

A virtual camera will make the computer believe it is connected to a camera, even if it is not.

• Choose Connect to Camera from the View menu, or click the Camera button in the Ramp Editor.
• Set the Connect To menu to one of the virtual cameras.
• Click the Connect button.

How to Disconnect from a Camera

It is not necessary, but a good idea to disconnect from the real camera when you quit the RPC, put
the computer to sleep or shut it down. When you unplug the cable, you do not have to disconnect; the
RPC will attempt to re-connect until the cable is plugged back in.

When you unplug the RPC cable temporarily (between setups, for instance), it is best to unplug the
RPC cable from the USB adapter, instead of unplugging the USB adapter from the computer.

• Choose Connect to Camera from the View menu.
• Click the Disconnect button.
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How to Execute a Ramp

• Make sure the Camera Controller is open, and connected to a camera.
• Make sure the Ramp Editor is open, and that the camera chosen from the Camera menu is the

same as the camera you are connected to.
• In the Camera Controller, switch the Mode Switch to Ramp.

Mode Switch

Trigger Button Run Button

• Click the Run button. The camera will run at the first speed set in the Ramp Editor.
• Click the Trigger button to start the ramp. The fps and shutter angle values will change.
• In the Ramp Editor, an orange line will move through the ramp to indicate the current position.

Current Ramp Position is
indicated by orange line

Notes on Video Playback

Currently, only speeds that are faster than the playback speed set in the Preferences can be
previewed on an external video monitor. Speeds slower than the playback speed will not play
properly on an external video monitor, and can only be previewed on a computer monitor.
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Part 2: Reference
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Reference Introduction

This part lists all windows and menus of the Ramp Preview Controller with a short description for
each item.

The Ramp Editor

The Ramp Editor is the RPC’s main window; it allows creating and editing of ramps. Ramps are
stored in a Ramp Archive; the Ramp Editor displays one Ramp Archive file. The Ramp Archive’s
name is displayed in the Ramp Editor’s title bar. The Ramp Editor window can be resized.

From this window the other two important windows, the Preview and the Camera Controller window,
can be opened by clicking the Preview or Camera buttons.

Ramp Menu

Zoom In Zoom Out Zoom Level

Ramp Point

Ramp Graph

Open Movie in Preview Window Open Camera Controller
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Ramp Menu

All ramps stored in the currently open Ramp Archive are listed in this menu. Use this menu to select a
Ramp for viewing, editing and previewing. The ramp name can be changed by selecting it and typing
a new name.

New Button

Click the “New” button to create a new Ramp. This ramp will be stored with the already existing
ramps in the currently open Ramp Archive.

Delete Button

Click the “Delete” button to delete the ramp that is currently visible. This will erase the ramp from the
currently open ramp archive.

Ramp Mode (Internal/External)

Choose here the mode for the currently visible ramp.

An internal ramp is a speed change that is stored in the camera’s internal memory. Internal ramps are
possible with the 535, 535B, 435 and 435ES, but not with the 16SR3. An external Controller, like the
Ramp Preview Controller (RPC), the Laptop Camera Controller (LCC) or the Camera Control Unit
(CCU) is necessary to create an internal ramp and to send it to the camera. The RCU and WRC
cannot change the internal ramp in a camera. Once an internal ramp is stored in the camera, it can
be activated and executed without an external controllers. Internal ramps are limited to a first and
second speed, and to a 100 second shoot time duration. .

An external ramp is a speed change that is stored in the memory of an external controller like the
Ramp Preview Controller. To activate and execute an external ramp, the controller has to be
connected to the camera. Since external controllers can have more memory and processing capacity
than the camera has, external ramps can be more sophisticated, including special features such as
multiple step ramps or exponential ramps.

Ramp Type (Linear/Exponential)

Only external ramps provide the choice of two different methods of speed change: linear and
exponential. This choice will not be visible when an internal ramp mode is chosen.

Until the Ramp Preview Controller, all ramps were linear. A linear ramp has a constant rate of
change. On a graph, a linear ramp is represented by a straight line. Linear ramps should be used
when the fastest ramp duration is desired.

Even though linear ramps can have the shortest duration, they have one disadvantage. Assuming a
ramp going from a slow to a fast speed, the perceived effect (change in the speed of motion) will be
very pronounced in the beginning of the ramp, with very little effect visible in the remainder. This is
due to the fact that as the shooting fps increases, playback takes exponentially longer. This
disadvantage becomes more apparent the longer the ramp duration and the higher the top fps is.To
counter this effect, the ramp itself needs to be exponential. By their very nature, exponential ramps
take longer than linear ramps. During playback, though, an exponential ramp will show the effect of
changing the speed of motion smoothly over the whole duration of the ramp.
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Camera Menu

This menu allows you to set the camera you will be using, which will determine:

• maximum and minimum fps,
• maximum fps per second (fps/s) limit,
• electronic shutter present or not,
• internal ramps possible or not.
Choose the last item in the “Camera” menu to get help and a list of the limits imposed by the different
cameras. Please note:

• The maximum shutter angle change per second is set by the "Compensation" menu.
• How fast a ramp can be is based on the setting in this menu and on the setting in the

"Compensation" menu.
• When switching to a different camera in this menu, the ramp will be automatically adjusted to match

the properties of the new camera. This can be reversed by immediately choosing "Undo" from the
"Edit" menu.

• The 4 and 3 perf versions of the same camera model have identical ramping properties.
• The “None” setting carries no limits, thus ramps can be created and previewed that cannot be

executed by a film camera, but that can be created in post production.

Compensation Menu

This menu allows you to set the type of exposure compensation you will be using, which will
determine:

• maximum fps range that can be compensated for,
• maximum shutter angle change/s,
• maximum fps/s.
Choose the last item in the “Compensation” menu to get help and a list of the limits imposed by the
different compensation methods. Please note:

• Other camera properties are set by the "Camera" menu.
• How fast a ramp can be is based on the setting in this menu and on the setting in the "Camera"

menu.
• When switching to a different compensation method in this menu, the ramp will be automatically

adjusted to match the limits of the new method. This can be reversed by immediately choosing
"Undo" from the "Edit" menu.

• A complete list of camera properties can be found in the Camera Menu's Help window.
• When using Ramps on a 535A or 435ES, shutter values are always sent along with fps values.

Make sure the shutter values correspond to your desired effect, i.e. when not using the Electronic
Shutter compensation method, you must manually set the first and last shutter to the same value!

Send to Camera Button

Only enabled when ramp mode is internal. Click this button to send the currently visible internal ramp
to the camera. The ramp will be stored in the camera’s memory.

Add & Delete Buttons

Only enabled when ramp mode is external. Click the “Add” button to add another ramp segment, click
the “Delete” button to delete a selected ramp segment.
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FAP Button

Only enabled when a ramp segment is selected. Click this button to make the selected ramp segment
as Fast As Possible, to set it to the minimum ramp time for the camera and compensation chosen.

Preview Button

Click the “Preview” button to open a movie for preview.

Camera Button

Click the “Camera” button to open the Camera Controller window.

Ramp Graph

The ramp graph shows camera speed (fps) on the vertical axis, and time on the horizontal axis.

Time is shown in the following format: MM:SS.T, where MM are minutes, SS are seconds, and T are
tenth of seconds. So the value “11.8” is 11 seconds and 8 tenth of a second. The value “2:12.7” is 2
minutes, 12 seconds and 7 tenth of a second. The red numbers above the index line show the
screentime, the gray numbers below the shoot time.

Ramp Points  are editable instances in a ramp. Each ramp point, when selected (clicked on), will
show its fps, shutter angle, shoot time and screentime below the ramp graph. Ramp points come in
two flavors: automatic ramp points are instances where the camera will automatically continue with
the ramp once the automatic ramp point is reached. Manual ramp points are instances where the
camera will remain at the speed of that point until the Ramp Trigger button is manually pushed.

A Ramp Segment  consists of a ramp point and all speed, shutter and duration values from the
previous ramp point to this ramp point. When a ramp point is clicked, the whole ramp segment is
selected and turns orange (see picture).

Ramp Points can be moved by dragging them around the graph. A yellow info box will appear,
showing the most important information about that ramp point.

Speed
(fps)

Time 
Shoot time

Screentime

Automatic Ramp Point

Manual Ramp Point
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Zoom Controls

The zoom controls allow you to increase or decrease the horizontal resolution of the ramp graph. The
zoom level shows which of the 7 zoom settings is currently active.

Fps & Shutter Fields

The fps and shutter fields show the speed of the currently selected ramp point. A new speed can be
entered by selecting the text and typing a new number. A new speed can also be entered by
choosing a value from the menu associated with the Fps and Shutter fields. If the value in the text
field is not in the menu, the first menu item will be “Add XX to the list”. If this item is chosen, the
number in the text field will be entered into the menu. If the number is already in the menu, the first
menu item allows you to remove it. Thus this menu can be easily and quickly customized.

Shoot Time and Screentime Fields

Shoot time is the amount of time it will take to shoot the selected ramp segment.

Shoot time is defined as the amount of time it takes to shoot an event. If, for instance, a car drives in
4 seconds from point A to point B, shooting this event will also take 4 seconds, no matter what fps
rate the camera is running at.

Screentime is the time it will take to play back the selected ramp segment.

Screentime is defined as the time it takes to playback a length of film. It is the time the event filmed
will be visible on screen. Screentime is determined by shoot time, shooting fps, and playback fps. If
our car driving for 4 seconds was shot at 24 fps and played back at 24 fps, screentime would also be
4 seconds. If, on the other hand, the car was shot at 48 fps, we would have generated twice as much
film in those 4 seconds of shoot time. Playback at 24 fps, then, would result in 8 seconds of
screentime.

Playback fps can be set in the Preferences window.

Advance: Automatic (A) & Manual Ramp Trigger (M)

Ramp points come in two flavors: automatic ramp points are instances where the camera will
automatically continue with the ramp once the automatic ramp point is reached. Manual ramp points
are instances where the camera will remain at the speed of that point until the Ramp Trigger button is
manually pushed.
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The Preview Window

The Preview window allows you to preview either a ramp or an offspeed. A ramp preview will apply
the fps changes defined in the Ramp Editor to a movie, thus allowing you to see what this ramp will
look like once it is filmed. An offspeed preview allows you to see what the movie would look like if the
film camera would have run at a different (but constant) speed.

Preview Trigger Preview TimelinePreview In Flag Preview Out FlagPreview Status

Offspeed TabRamp Tab

Ramp Tab

Click on the Ramp tab to preview the ramp displayed in the Ramp Editor window. The controls in the
Ramp tab are only enabled if the Ramp Editor Window is open.
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Offspeed Tab

Click on the Offspeed tab to preview what the movie would look like if the film camera would have run
at a speed other than the playback speed defined in the Preferences. This tab is always available,
even when the Ramp Editor window is not open.

Preview Status

Preview Status shows the shoot fps used for this preview, the shoot time, screentime and film
needed. Please note that the shoot time, screentime and film needed are based on the positions of
the Preview In and Preview Out flags. Moving those flags will change the numbers in the Preview
Status.

QuickTime Controls

Directly underneath the movie are the normal QuickTime controls. They allow for changing of the
sound level, normal speed playback and stepping through the movie one frame at a time. Please note
that the QuickTime play button will always play the movie at normal speed. A preview can only be
achieved with the Play Preview button.

Note: When previewing an offspeed, the arrow keys on the keyboard have two functions that can be
switched with the tab key: they can step through the numbers in the Shoot fps combo box, or they
can change the QuickTime audio volume.

Set Volume

Play at Normal Speed

Slider shows current Position in Movie

Step Back/Forward
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The Preview Window - Ramp Preview

Ramp Tab

Make sure the Ramp tab is in the front when previewing ramps.

Record Triggers Button

Once the Record Triggers button is clicked, all existing preview triggers will be erased, and the movie
will play at normal speed. At the moment in the movie where you want a preview trigger to occur, click
the Set Trigger button. A preview trigger will be placed in the preview timeline.

1. Click Record Triggers to erase all existing Preview
   Triggers and to play movie at normal speed.

2. Once you the movie reaches the point where you want
   the ramp to start, click Set Trigger.

3. Click Play Preview to view the ramp preview.

Ramp Tab

Set Trigger Button

Once the Record Triggers button is clicked, all existing preview triggers will be erased, and the movie
will play at normal speed. At the moment in the movie where you want a preview trigger to occur, click
the Set Trigger button. A preview trigger will be placed in the preview timeline.

Play Preview

Once at least one Preview Trigger has been set, you can use the Play Preview button to playback the
preview. The preview will start at the Preview In Flag, and end at the Preview Out Flag. It will speed
up or slow down the playback of the movie to simulate what the ramp in the Ramp Editor window will
look like once filmed. Please note that how fast the movie will be played back by the RPC is based on
the speed set here AND on the playback speed set in the Preferences.

Preview In Flag

This green flag defines the point in the movie where the preview will begin playing from. Drag the flag
left/right to adjust the in point.

Preview Out Flag

This red flag defines the point in the movie where the preview will stop playing. Drag the flag left/right
to adjust the out point.
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Preview Timeline

The Preview Timeline is where the Preview Triggers and Preview In/Out Flags are set. Preview
Trigger define where in the movie  a ramp point is triggered. Preview In and Preview Out Flags show
how much of the movie can be previewed; only the part of the movie between those flags will be
played back during a preview.

Preview Trigger Preview TimelinePreview In Flag Preview Out Flag

Preview Trigger

A Preview Trigger defines where in the movie the RPC will simulate a Ramp Trigger button push. You
must at least set one Preview Trigger, so the RPC knows where in the movie you want the ramp to
start. The numbers on the Preview Triggers correspond to the numbers on the Ramp Points in the
Ramp Editor.

A quick way to set a Preview Trigger is this:

• Move the cursor over the Preview Timeline.
• Push the mouse button down and keep it held down. Now move the cursor to the left or right; you

will scrub through the movie.

Preview Trigger

• Once you get to the place in the movie where you want the Preview Trigger to occur, let go of the
mouse button.

If you want to rehearse the trigger button push, you can use this alternate method:

• Click the Record Triggers button. This action will erase all existing Preview Triggers and play the
movie at normal speed.

• Once the movie reaches the point where you want the preview trigger to occur, click either the Set
Trigger button, or use the keyboard shortcut (The default is F-9, but if you changed the Shortcut
settings in the Preferences it could be something else).

Preview Triggers can be dragged to a different position at any time. They can be erased by dragging
them down, out of the Preview Timeline. The cursor will take on the shape of a trash can to indicate
that a Preview Trigger will be erased.
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The Preview Window - Offspeed Preview

Preview TimelinePreview In Flag Preview Out FlagPreview Status

Offspeed Tab

Offspeed Tab

Make sure the Offspeed tab is in the front when previewing ramps.

Preview In Flag

This green flag defines the point in the movie where the preview will begin playing from. Drag the flag
left/right to adjust the in point.

Preview Out Flag

This red flag defines the point in the movie where the preview will stop playing. Drag the flag left/right
to adjust the out point.
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Play Preview

Click the Play Preview button to see what the movie would look like if it would have been shot with a
film camera at the speed set in the Shoot fps combo box. The preview will start at the Preview In
Flag, and end at the Preview Out Flag. Please note that how fast the movie will be played back by the
RPC is based on the speed set here AND on the playback speed set in the Preferences.

3. Click Play Preview.

2. Set the camera speed you want to preview.

1. Set the Film Format.

Shoot fps

Type a speed into or choose a speed from this combo box. Once you click the Play Preview button,
the RPC will play the movie back as it will look when shot at this speed. Please note that how fast the
movie will be played back by the RPC is based on the speed set here AND on the playback speed set
in the Preferences.

Once the combo box has been clicked on, you can quickly step through the numbers in the menu with
the arrow up or down keys on the keyboard. To use the arrow up/down keys to change the
QuickTime audio volume, either click in the movie window or hit the tab key once.

Film Format

To properly calculate the film needed for any given offspeed, the RPC needs to know what film format
will be used. During a Ramp Preview, the film format is automatically preset by the choice of camera
in the Camera menu in the Ramp Editor. For an Offspeed Preview the film format has to be entered
manually.

Preview Timeline

The Preview Timeline shows how much of the movie can be previewed through the Preview In and
Preview Out Flags. Only the portion of the movie between those flags will be played back during a
preview. The whole movie can still be played back using the QuickTime controls.
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The Camera Controller Window

The Camera Controller window allows basic remote control of a connected film camera, including
run/stop, activation of ramp mode, camera status display, ramp trigger, phase, changing of fps and
shutter angle.

Status Information Camera Type/Camera Messages

Camera Mode Switch Speed Combo Box Shutter Combo Box

Connect to Camera Button

When the Camera Controller is not connected to a camera, the left side will be empty except for the
“Connect to Camera” button. Click that button to open the Connect to Camera window.

Camera Mode Switch (Normal/Ramp)

Slide this switch to the right to put the camera in ramp mode, to the left for normal use. In ramp mode,
the Ramp Trigger button will be available, speed and shutter cannot be changed from the Camera
Controller and the Ramp Editor window cannot be edited until the camera mode is switched back to
Normal.

Speed Combo Box

A new speed can be set on the camera by selecting the text and typing a new number. A new speed
can also be set by choosing a value from the menu associated with the Speed field. A new speed
entered will be transmitted immediately to the camera.

If the value in the field is not in the menu, the first menu item will be “Add XX to the list”. If this item is
chosen, the number in the field will be entered into the menu. If the number is already in the menu,
the first menu item allows you to remove it. Thus this menu can be easily and quickly customized.

Shutter Combo Box

A new shutter angle can be set on the camera by selecting the text and typing a new number. A new
shutter angle can also be set by choosing a value from the menu associated with the shutter field. A
new shutter angle entered will be transmitted immediately to the camera.
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If the value in the field is not in the menu, the first menu item will be “Add XX to the list”. If this item is
chosen, the number in the field will be entered into the menu. If the number is already in the menu,
the first menu item allows you to remove it. Thus this menu can be easily and quickly customized.

Status Information

Camera status is shown by the color of the Camera Controller background. When the Camera is in
standby, the background is gray. When the camera is running, the background is green. When the
camera is not ready, the background is red. When the camera is not ready, the ARRI logo will be
replaced by a message, identifying the reason for the not ready state.

To the left is the speed the camera is set at, the shutter angle (only visible on cameras with an
electronic shutter) and the TOTAL footage counter. The footage counter will not be visible during
external ramps.

Camera in standby, set to 24 fps and 180° shutter

The model number of the connected camera

Camera running

A RRI logo rotates during camera run
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Camera not ready because movement  is not completely closed

The ARRI logo is replaced by a short message indicating why the camera is not ready

Please note that different camera models behave differently when a roll out occurs. The 535, 535B
and 16SR3 can be reset by pushing the Run button, on the camera or in the Camera Controller
window. The 435 has to be reset by opening the magazine release lever on the camera itself; the 435
cannot be reset from the Camera Controller window.

Trigger Button

When the Camera is put in ramp mode, the Trigger button will be available. Once a ramp is
executing, clicking the Trigger button will trigger the next ramp segment.

Ramp Trigger Button

Camera Controller   is in Ramp mode, Ramp Trigger button is visible

Phase Button

When the camera is in standby, clicking the Phase button will inch the camera. On cameras without
an electronic mirror shutter, after about 20 seconds the mirror shutter angle will be displayed.

When the camera is running, its speeds increases by 0.2 fps.

Run Button

Click here to run/stop the camera. When the camera is not running (in standby), the Camera
Controller background will be gray. When the camera is running, the background will be green, and
the ARRI logo will rotate.
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The Connect To Camera Window

Connect To Menu

This menu allows you to connect to a real or a number of virtual cameras. A virtual camera makes the
computer believe that it is connected to a camera, even if it is not. Virtual cameras are a great tool for
familiarizing yourself with the software and the features of the supported ARRI cameras.

Connect Through Menu

The communication ports available to your computer will be listed in this menu. If you plug a USB
adapter into the computer but it does not show up in this menu, close the window and open it again to
reset the menu.

Status

The “Status” text show the current status of the connection.

Close This Window on connect Checkbox

When this box is checked, the Connect to Camera window will close once a connection is
successfully established.

Help Button

Click on the “Help” button to display help on using the Connect to Camera window.

Connect Button

Click the “Connect” button to attempt connecting to the camera chosen in the “Connect To” menu.

Disconnect Button

Use the “Disconnect” button to terminate the connection.
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Preferences

Section List

The Preferences are divided into four different sections: General, Ramps, Shortcuts and Alerts. You
access a section by clicking the respective icon in the Section list. It is a very good idea to familiarize
yourself with these settings, as they often determine the underlying behavior of the other parts of the
program.

Most importantly, the Playback Speed set in the Ramp section determines the preview behavior of
the Preview window.
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Preferences - General

Autosave Ramp Archives Every XX Minutes

When checked, this option will save Ramp Archives to the hard disk in the time interval specified.
Saving is suspended while connected to a camera and the camera is running.

On Startup

Choose here what the Ramp Preview Controller should do when it starts up.

• Do Nothing: The program will start with the Camera Controller and Connect to Camera windows in
the same positions that they were in when the program was quit.

• Ask which Existing Ramp Archive to Open: the program will bring up a dialog asking you to open an
existing ramp archive file.

• Open Default Ramp Archive: Here you can select a ramp archive that will automatically be opened
when the program starts. The file's name will be displayed underneath this option. Use the "Select"
button to choose a file.

Show Film in

This sets the unit of measurement (feet or meters) that will be used in the Ramp Editor and in the
Preview window to display the amount of film needed. Note: The Camera Controller will always use
the unit of measurement of the camera to display the camera film counter.
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Preferences - Ramps

Change Ramp Points on Graph in XX fps Steps

This setting determines in what increments the program will attempt to change fps when you move a
ramp point on the graph. The actual increment used may be larger than the one set here since the
smallest increment that can be displayed depends on the size of the Ramp Editor window.

Please note that this setting does not limit what values can be entered in the text fields below the
ramp graph - those can still be in smaller increments.

Playback fps

This setting defines the normal playback speed for all previews, and is thus very important. It is also
the basis for the screentime calculation. It cannot be higher than the maximum speed for the "None"
camera.

Note: The baseline in the graph shows this value. Clicking on this number to the left of the graph will
cycle through the 3 most common telecine playback speeds of 24, 25 and 30 fps.

When Camera Menu is set to "None": Maximum Speed XXX fps

When the "Camera" menu is set to "None", the value entered here will be used to set the maximum
fps displayed in the graph. This number cannot be lower than the Screentime Playback fps. When the
"Camera" menu is set to "None", the minimum fps used in the graph is always 1.

When Camera Menu is set to "None": Film Format for Film Calculation

When the "Camera" menu is set to "None", the film needed displayed  in the Ramp Editor and in the
Preview window is calculated based on this film format.
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Preferences - Shortcuts

Here you can assign F-Keys and normal keyboard keys as shortcuts for the most common camera
control and preview commands. The camera control commands (Normal/Ramp Mode, Camera
Run/Stop, Ramp Trigger and Phase) will always work, whereas the three preview commands
(Preview Set Trigger, Play/Stop Movie and Play/Stop Preview) only work when the Preview window is
in the foreground.

Caution: As long as a key is assigned here, you will not be able to use this key in Ramp names.

Note: Other shortcuts can be found in the menus behind the menu commands and in the "Keyboard
Shortcuts" window accessible from the "Help" menu.
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Preferences - Alerts

Some Alerts can be prevented from appearing again with a "Don't Show Again" checkbox in the Alert
itself. This is where they can be enabled again.
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File Menu

New Ramp Archive

When no ramp archive is open, this command will create a new ramp archive. Ramp archives are
files created by the RPC that store a number of ramps.

Open Ramp Archive…

This command will lead to a directory dialog that allows you to open an existing ramp archive. Only
one ramp archive can be open at a time.

Close

This command will close the window in the foreground.

Save Ramp Archive

This command will save the currently open ramp archive.

Save Ramp Archive As…

This command will make a copy of the currently open ramp archive and save it under a new name.

Deauthorize…

This command allows you to remove the authorization to run the RPC from this computer and move it
back to the hardware key. This is so you can remove the RPC from one computer and install it onto
another without loosing any legal installs.

Quit

This command will quit the RPC.
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Edit Menu

Undo

This command will undo the last action performed.

Cut/Copy/Paste/Clear/Select All

These are the standard commands found in any program and should be explained sufficiently in your
computers documentation.

Preferences

This command will open the RPC Preferences window.
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View Menu

Connect to Camera

This command will either bring the Connect to Camera window to the foreground, or, if it is not open,
will open the Connect to Camera window.

Camera Controller

This command will either bring the Camera Controller window to the foreground, or, if it is not open,
will open the Camera Controller window.

Ramp Editor

This command will either bring the Ramp Editor window to the foreground, or, if it is not open, will
allow you to open an existing Ramp Archive or to create a new one.

Preview Window

This command will either bring the Preview window to the foreground, or, if it is not open, will allow
you to open a movie.

Quick Help

This command allows you to enable or disable Quick Help.

When Quick Help is enabled, you can rest the cursor over any item on the screen, and a small
explanation will pop up. The Quick Help item in the “View” menu has a checkmark when it is enabled,
no checkmark when it is disabled.
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Preview Menu

Open Movie…

This command allows you to choose a movie that will open in the Preview window.

Record Triggers

Choose this command to record preview triggers. Once the Record Triggers command is chosen, all
existing preview triggers will be erased, and the movie will play at normal speed. Use the Set Trigger
button or menu command to place preview triggers.

Set Trigger

Once the Record Triggers command has been issued, all existing preview triggers will be erased, and
the movie will play at normal speed. At the moment in the movie where you want a preview trigger to
occur, choose the Set Trigger command. A preview trigger will be placed in the preview timeline.

Play Preview

This command will behave slightly different, based on which tab is chosen in the Preview window.

For Ramp preview , once at least one Preview Trigger has been set, use the Play Preview command
to playback the preview. The preview will start at the Preview In Flag and end at the Preview Out
Flag. It will speed up or slow down the playback of the movie to simulate what the ramp in the Ramp
Editor window will look like once filmed. Please note that how fast the movie will be played back by
the RPC is based on the speed set here AND on the playback speed set in the Preferences.

For Offspeed preview , choose the Play Preview command to see what the movie would look like if it
would have been shot with a film camera at the speed set in the Shoot fps combo box. The preview
will start at the Preview In Flag, and end at the Preview Out Flag. Please note that how fast the movie
will be played back is based on the fps set here AND on the playback speed set in the Preferences.

Half/Normal/Double, 1.95 Size

This command changes the size of the movie and of the Preview window. The 1.95 Size command
will allow playback through some video cards that could not playback at Double Size.
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Help Menu

Macintosh Only: About Balloon Help & Show Balloons

About Balloon Help will show a window with information about, well, Balloon Help. Show Balloons
turns Balloon help on. Since the RPC does not use Balloon Help, ignore those two commands.

Ramp Tutorial

This short tutorial is required reading for anyone who works with ramps! It defines and explains the
following terms: Ramp, Internal Ramp, External Ramp, Linear Ramp, Exponential Ramp, Shoot time,
Screentime and Reverse Ramp. It also discusses exposure compensation and the use of ramps with
HMI lights.

Reverse Ramps

A short text on what a reverse ramp is and how to run them with the different models ARRIFLEX
cameras.

Keyboard Shortcuts

A short description of keyboard shortcuts available in the RPC.

Customer Support

A listing of ARRI Group sales offices and ARRI owned rental facilities.


